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CodingFTP Help

Welcome

Using script to automate the FTP operation

CodingFTP is a software to help you to automate the FTP transfers. You can easily upload file to FTP
server, download files from FTP server, change file permission. Do any FTP operation, automatically.

[C codingFTP 2008 (Trial Version) =B

- |2) sampleScript L.cfe | What do you want to do?
lé] SampleScript 2.cfs
- |2) samplesaipt3.cfe | Open Coding FTP Script Wizard
LT—"J SampleScript 4.cfs
2] sampleSeript 5.cfs Open an existing scri
ﬁ Java Script Samples Create a new category
2] sampleScript 1.cfs ' : '
lﬂ SampleScript 2.cfs
@ Samplescript 3.cfs
E] Samplescript 4.cfs
|2} sampleSeript S.cfs |
& Myscripts

-~ 2 My Script.cfs
|2} Mew Script 2.cfs
|2} Mew Script 3.cfs
—[2) Mew Scriptd.cfs
|£2| New Script444.cfs
ﬂ (Recyde Bin)

A

Note: CodingFTP isn't intend to be a replacement of traditional FTP client. It's designed for
unattended, repeat, automated tasks. You may still need a traditional FTP client for manually
operation.
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Script Language Introduction

When we talking about writing script, you may think it's difficult. However, Coding FTP provides
several

1) Easy to use script language

Coding FTP uses Java Script and Basic Script syntax. They are both widely used script languages.
You may already see them in Windows and web pages. It's almost no learning curve if you have any
programming experience.

2) Easy to use command option
Writing command in Coding FTP is likely writing command line in DOS window. Coding FTP uses
similar syntax.

For example, to establish a FTP connection, you can use following command in script:
OpenHost ("/host=127.0.0.1 /username=myusername /passwd=mypasswd") ;

As you can see, it's very similar to write a command line.

3) Script Wizard
Coding FTP also has an easy to use Script Wizard to help you write the script. You can open it in the
main window of Coding FTP.
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Where to start?

1) Firstly, you may want to see or run some script samples so that you can have the first
impression on Coding FTP

You can open the sample scripts from the Basic Script Samples and Java Script Samples
categories in Script Library.

Script Library n

" Basic Script Samples
|2 sampleScript 1.cfs
|z] sampleScript 2.cfs
SampleScript 3.cfs
SampleScript 4.cfs
SampleScript 5.cfs

B 1ava Sript Samples
: SampleScript 1.cfs
SampleScript 2.cfs
SampleScript 3.cfs
Saipt 4.cfs
| sSampleScript 5.cfs

I

[ ) ) 1

b Myscripts

|2 My Script.cfs *

o) Mew Script 1.cfs *

Ml (Recyde Bin}

o [2) Mew Script 2.cfs
|2] Mew Script 3.cfs
|2] Mew Script4.cfs
|2] Mew Script444.cfs

2) Then, you can use Coding FTP Script Wizard to help you write some simple scripts.

You can open the wizard by clicking "File->New->Open Script Wizard"; Or, press Ctrl+W.
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4.1

Script Command

CodingFTP has about 20 commands. You can use them in the script to do any FTP operations.
Coding FTP uses Java/VB Script syntax for all commands. It's almost no learning curve if you have
programming knowledge.

We also provide Script Writing Service if you have no any knowledge about coding or you simply don't
want to take time to write the script. For either case, we are glad to write the script for you at a
reasonable fee. More information about the SWS, please refer to Script Writing Service section.

Script Sample

Let's see a simple example which demonstrates how to establish the connection with a FTP server.
You can also open them from "Java Script Samples" and "Basic Script Samples" in Script Library.

JScript Example:

hostaddr = "localhost";
username = "anonymous";
passwd = "";

connected = false;
retrytimes = 1;

connected = OpenHost ("/host=$hostaddr /username=$username /passwd=S$passwd");

while ( !connected && (retrytimes <= 3) )

{
WriteLog("Retrying..." + ToStr (retrytimes));
Sleep("/s=2");
retrytimes++;

connected = OpenHost ("/host=$hostaddr /username=$username /passwd=S$passwd");

}

if (connected)

{
WriteLog ("Connected successfully!");
CloseHost;

}

else

{

WriteLog("Connection failed, error message: " + ErrorText);

}

Basic Script Example:

hostaddr = "localhost"

username = "anonymous"

passwd = ""

connected = false

retrytimes = 1

connected = OpenHost ("/host=$hostaddr /username=Susername /passwd=$passwd")

while ( not connected and (retrytimes <= 3) )

WriteLog("Retrying..." & ToStr (retrytimes))

Sleep (" /s=2")

retrytimes = retrytimes + 1

connected = OpenHost ("/host=$hostaddr /username=$username /passwd=S$passwd")
wend

if (connected) then
WriteLog ("Connected successfully!")
CloseHost
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else
WriteLog("Connection failed, error message: " & ErrorText)
end if

4.2 Connection

¢ INITServerlnfo
e OpenHost
e CloseHost

4.2.1 INITServerinfo

Description:
Initializing server information

Options:
Itz Time zone of FTP server. Available values:
auto: If it's the first time to connect to the FTP serve, CodingFTP will use detect option to
check it's timezone; Otherwise, CodingFTP will use stroed timezone
detect: CodingFTP always try to detect the time zone of FTP server.
a specified time zone: You can also specify the time zone directly if you know it.
/timeaccuTime accuracy. How CodingFTP compares file timestamp. Available values:
auto: If your FTP server supports MLST command, CodingFTP uses "second" accuracy;
otherwise, "minute" accuracy will be used
m: Minute accuracy. 20:12:15 is equal to 20:12:40
s: Second accuracy. 20:12:15 is older than 20:12:40

Default Option:
ltz=auto
/timeaccu=auto

JScript Example:

INITServerInfo ("/tz=auto /timeaccu=m") ;

Basic Script Example:
INITServerInfo ("/tz=auto /timeaccu=m")

See Also:
4.2.2 OpenHost

Description:
Establish connection with a FTP server

Options:

/host FTP server address

/port FTP server port. Default value is 21, you don't need to change it in most cases
/ Username on the FTP server

usernam

e

/passwd Password of above user

Isite Site ID/Name in Site Manager

© 2008 Fevosoft
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/account Account ID/Name in Site Manager

Remark:
Normally, if you only need to connect to a non-secure FTP server, you can simply use following

parameters in command:
"/host=127.0.0.1 /username=John /passwd=mypasswd"

However, if you need to connect to a secure FTP server or you need to use proxy, etc. You need to

use the /site and /account. e.g.
"/site=mysite /account=myaccount"

The mysite and myaccount are the user defined Site/Account in Site Manager. To launch Site
Manager, please click "Edit->FTP Site Manager" on main window of Coding FTP

JScript Example:

OpenHost ("/host=127.0.0.1 /username=John /passwd=mypasswd") ;

Basic Script Example:
OpenHost ("/host=127.0.0.1 /username=John /passwd=mypasswd")

See Also:
CloseHost

4.2.3 CloseHost

Description:
Close the connection from a FTP server

Options:
(no
option)

JScript Example:
if ( OpenHost ("/host=127.0.0.1 /anonymous") )
CloseHost;

Basic Script Example:
If OpenHost ("/host=127.0.0.1 /anonymous") Then
CloseHost

See Also:
OpenHost

4.3 File Operation
4.3.1 DownloadFile

Description:
Downloading file(s) from FTP server. The file downloading is a basic and important feature for FTP
operation. CodingFTP provides a very convenient way to download file(s)

Options:

/ftp File(s) need to be downloaded. A single file or a path with wildcard.
/localdir A directory on local computer to store files

/subdirs Including sub directories if specified
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/ New file name on local disk

newname

lifnewer Download file only when FTP file newer than local copy
liflarger Download file only when FTP file larger than local copy
/ifnotexist Download file only when it's not exists in local computer

Iflat Download files from FTP server and store all of them in local directory without sub directory
/exclude Exclusion filter
[cre Using XCRC command to verify files after downloading, make sure all files were downloaded

successfully
Result:
Boolean value

True : All files were downloaded successfully or no file was downloaded
False : Error occurred when download files

JScript Example:

DownloadFile ("/ftp=/usrs/lewis/html/*.* /localdir=d:\temp\html /subdirs");
DownloadFile ("/ftp=/usrs/lewis/html/*.jpg /localdir=d:\temp\html\jpgs /subdirs");
DownloadFile ("/ftp=/usrs/lewis/html/mainwindow.jpg /localdir=d:\temp\html\jpgs");

DownloadFile ("/ftp=/usrs/lewis/html/mainwindow.jpg /localdir=d:\temp\html\jpgs /newname=backup.jpg");
Basic Script Example:

DownloadFile ("/ftp=/usrs/lewis/html/*.* /localdir=d:\temp\html /subdirs")

DownloadFile ("/ftp=/usrs/lewis/html/*.jpg /localdir=d:\temp\html\jpgs /subdirs")

DownloadFile ("/ftp=/usrs/lewis/html/mainwindow.jpg /localdir=d:\temp\html\jpgs")

DownloadFile ("/ftp=/usrs/lewis/html/mainwindow.jpg /localdir=d:\temp\html\jpgs /newname=backup.jpg")

See Also:
UploadFile, SyncDir

4.3.2 UploadFile

Description:
Uploading file(s) to FTP server. The file Uploading is a basic and important feature for FTP operation.
CodingF TP provides a very convenient way to Upload file(s)

Options:

/local File(s) need to be uploaded. A single file or a path with wildcard.
[ftpdir A directory on FTP server to store files

/subdirs Including sub directories if specified

/ New file name on FTP server

newname

/ifnewer Upload file only when local file is new than the copy on FTP server
liflarger Upload file only when local file is larger than the copy on FTP server
lifnotexistUpload file only when it's not exists on FTP server

[flat Upload files to FTP server and store all of them in remote directory without sub directory
/hidden Upload hidden files
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Isys Upload sys files

/exclude Exclusion filter

[crc Using XCRC command to verify files after downloading, make sure all files were downloaded
successfully

/emptydir Create directory on FTP server even if local directory is empty

JScript Example:

UploadFile ("/local=d:\temp\html\*.* /ftpdir=/usrs/lewis/html /subdirs");
UploadFile ("/local=d:\temp\html\jpgs\*.Jjpg /ftpdir=/usrs/lewis/html /subdirs");
UploadFile ("/local=d:\temp\html\jpgs\mainwindow.jpg /ftpdir=/usrs/lewis/html") ;

UploadFile ("/local=d:\temp\html\jpgs\mainwindow.jpg /ftpdir=/usrs/lewis/html /newname=backup.jpg");
Basic Script Example:

UploadFile ("/local=d:\temp\html\*.* /ftpdir=/usrs/lewis/html /subdirs")

UploadFile ("/local=d:\temp\html\jpgs\*.jpg /ftpdir=/usrs/lewis/html /subdirs")

UploadFile ("/local=d:\temp\html\jpgs\mainwindow.jpg /ftpdir=/usrs/lewis/html")

UploadFile ("/local=d:\temp\html\jpgs\mainwindow.jpg /ftpdir=/usrs/lewis/html /newname=backup.jpg")

See Also:
DownloadFile, SyncDir

4.3.3 SyncDir

Description:
Keep local directory and FTP directory in sync

Options:
/localdir A directory on local computer
/ftpdir A directory on FTP server

/ How to synchronize files? Possible values:
syncmeth
od updateft Upload all new and changed files to FTP server

P
updatedeUpload all new and changed files to FTP server and delete all obsolete files from

Iftp FTP server
updatelo Download all new and changed files to local computer
cal

updatedeDownload all new and changed files to local computer and delete all obsolete files
llocal from local computer
bisync

/subdirs Including sub directories if specified

/include Inclusion filter. Only files in inclusion filter will be transferred

/exclude Inclusion filter. All files in exclusion filter will NOT be transferred

[fastsync Using fast sync to speed up the sync process. If this option enabled, you should not manually
upload/edit files on FTP server as CodingFTP is not aware to these changes and this may
cause conflict.
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[crc Using XCRC command to verify the files to make sure they were uploaded/downloaded
successfully

JScript Example:

SyncDir ("/localdir=d:\lewis\htmls /ftpdir=/users/lewis/htmls /syncmethod=updateftp /subdirs /crc");

Basic Script Example:

SyncDir ("/localdir=d:\lewis\htmls /ftpdir=/users/lewis/htmls /syncmethod=updateftp /subdirs /crc")

See Also:
DownloadFile, UploadFile

4.3.4 SetSpeed

Description:
Set transferring speed

Options:
/kb Max speed in KB

/mb Max speed in MB

Default Option:
No speed limitation.

JScript Example:
SetSpeed ("/kb=60") ;

Basic Script Example:
SetSpeed ("/kb=60"

See Also:
4.3.5 SetTransferMode

Description:
Set transferring mode.

Options:
/binary  Using binary mode to transfer all files in 'exts'. Other files will be transferred in ascii mode. If
'exts' option isn't used, all files will be transferred in binary mode.

/ascii Using ascii mode to transfer all files in 'exts'. Other files will be transfered in binary mode. If
'exts’ option isn't used, all files will be transferred in ascii mode.
lexts File extension list.

Default Option:
"binary", all files will be transferred in binary mode.

JScript Example:
SetTransferMode ("/binary") ;
SetTransferMode ("/ascii /exts=*.txt;*.html;*.php");

Basic Script Example:
SetTransferMode ("/binary")
SetTransferMode ("/ascii /exts=*.txt;*.html;*.php")
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See Also:
4.3.6 SetFileDate

Description:
Change file timestamp

Options:
/local A local file
Iftp A ftp file

/date New modification time

Result:

Boolean value

True : Successfully updated file timestamp
False : Failed to update file timestamp

JScript Example:
if ( SetFileDate ("/ftp=/users/lewis/l.jpg /date=2008-3-10 13:23:40") )

{

WriteLog ("Update file timestamp successfully");

}

else

{

WriteLog("Failed to update file timestamp");
}

Basic Script Example:

If SetFileDate ("/ftp=/users/lewis/1l.jpg /date=2008-3-10 13:23:40") Then
WriteLog ("Update file timestamp successfully")

Else
WriteLog("Failed to update file timestamp")

End If

See Also:

4.3.7 SizeDiff

Description:
Compare the size of two files

Options:
ffile1 Full path of file1
ffile2 Full path of file 2

Result:

larger File1 is larger than file2; Or file2 isn't existing.
equal The size of file1 and file2 are equal

smaller File1 is smaller than file2; Or file1 isn't existing.
unknow Error occurred. e.g. unable to get file size

n

JScript Example:
if ( SizeDiff("/filel=d:\temp\l.jpg /file2=/users/lewis/2.3pg") == "larger" )
{
WriteLog("1l.jpg is larger");
}

© 2008 Fevosoft



Script Command

if ( SizeDiff ("/filel=/users/lewis/2.jpg /file2=/users/lewis/1.jpg") == "smaller" )
{

WriteLog("2.jpg is smaller");
}

Basic Script Example:

If SizeDiff ("/filel=d:\temp\l.jpg /file2=/users/lewis/2.jpg") = "larger" Then
WriteLog("1l.jpg is larger"

End If

If SizeDiff ("/filel=/users/lewis/2.jpg /file2=/users/lewis/1.jpg") = "smaller" Then
WriteLog("2.jpg is smaller")

End If

See Also:

TimeDiff

4.3.8 TimeDiff

Description:
Compare the timestamp of two files

Options:
ffile1 Full path of file1
ffile2 Full path of file 2

Result:

newer File1 is newer than file2; Or file2 isn't existing.
equal The timestamps of file1 and file2 are equal
older File1 is older than file2; Or file1 isn't existing.
unknow Error occurred. e.g. unable to get file timestamp
n

JScript Example:
if ( TimeDiff ("/filel=d:\temp\l.jpg /file2=/users/lewis/2.jpg") == "newer" )
{
WriteLog("1l.jpg is newer");
}

if ( TimeDiff ("/filel=/users/lewis/2.jpg /file2=/users/lewis/1.jpg") == "older" )
{

WriteLog("2.jpg is older");
}

Basic Script Example:

If TimeDiff ("/filel=d:\temp\l.jpg /file2=/users/lewis/2.jpg") = "newer" Then
WriteLog ("1l.jpg is newer")

End If

If TimeDiff ("/filel=/users/lewis/2.jpg /file2=/users/lewis/1.jpg") = "older" Then
WriteLog("2.jpg is older")

End If

See Also:

SizeDiff

4.3.9 FileExists

Description:
Checking whether a specified file exists
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Options:
/path A file on local computer or FTP server
Result:
True or False
JScript Example:
if ( FileExists("/ftp=/users/lewis/1l.jpg") )
{
WriteLog ("File exists");
}
else
{
WriteLog("File not exists");
}
Basic Script Example:
If FileExists ("/ftp=/users/lewis/1.jpg") Then
WriteLog ("File exists")
Else
WriteLog("File not exists")
End If
See Also:
DirExists
4.3.10 DirExists
Description:

Checking whether a specified directory exists
Options:

/path A directory on local computer or FTP server

Result:
True or False

JScript Example:
if ( DirExists("/ftp=/users/lewis") )
{
WriteLog ("Directory exists");
}
else
{
WriteLog ("Directory not exists");

}

Basic Script Example:

If DirExists ("/ftp=/users/lewis") Then
WriteLog ("Directory exists"

Else
WriteLog ("Directory not exists"

End If

See Also:
FileExists, CreateDir, DelDir
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4.3.11

4.3.12

Rename

Description:
Rename a file

Options:
/oldpath Origional file
/newpath New file name. If the path specified, the file may moved to new location.

JScript Example:

Rename ("/oldpath=/users/lewis/temp/1l.Jjpg /newpath=2.jpg");

Rename ("/oldpath=d:\temp\1l.Jjpg /newpath=d:\temp\backup\2.jpg") ;

Basic Script Example:

Rename ("/oldpath=/users/lewis/temp/l.jpg /newpath=2.jpg")

Rename ("/oldpath=d:\temp\1l.jpg /newpath=d:\temp\backup\2.jpg")
SetFilePermission

Description:
Change file permission on FTP server

Options:

Iftp A file on FTP server
/ New permission string.
permissioThere are 9 characters in the string. They represent owner permission, group permission
n and other permission. Every permission has three characters.
e.g. rwxr-xr-- means: the owner can read/write/execute, the group can read/execute, and
others can only read

Result:
Boolean value: True or False

JScript Example:
if ( SetFilePermission("/ftp=/users/lewis/l.jpg /permission=rwxr--r--") )
{
WriteLog ("Update file permission successfully");
}
else
{
WriteLog("Failed to update file permission");

}

Basic Script Example:

If SetFilePermission("/ftp=/users/lewis/l.Jjpg /permission=rwxr--r--") Then
WriteLog ("Update file permission successfully")

Else
WriteLog("Failed to update file permission")

End If

See Also:
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4.3.13 CreateDir

Description:
Create a new directory on local computer or FTP server

Options:

/path Directory name or full path

Result:
Boolean value: True or False

JScript Example:
if ( CreateDir ("/path=/users/lewis/newfolder") )

{

WriteLog ("Successfully created directory");

}

else

{

WriteLog("Failed to create directory");

}

Basic Script Example:

If CreateDir ("/path=/users/lewis/newfolder") Then
WriteLog ("Successfully created directory"

Else
WriteLog("Failed to create directory")

End If

See Also:
DelDir
4.3.14 DelFile

Description:
Delete a file from local computer or FTP server

Options:
/localfile A single file or a path with wildcard

/fipfile A single FTP file or a FTP path with wildcard
/subdirs Delete files in sub directories too if specified

JScript Example:

DelFile ("/localfile=d:\temp\*.* /subdirs");

DelFile("/ftpfile=/users/lewis/temp/*.tmp /subdirs");

Basic Script Example:

DelFile ("/localfile=d:\temp\*.* /subdirs")

DelFile("/ftpfile=/users/lewis/temp/*.tmp /subdirs")

See Also:
DownloadFile, UploadFile

© 2008 Fevosoft



Script Command

4.3.15

4.3.16

DelDir

Description:
Delete a directory from local computer or FTP server

Options:

/path Directory name or full path

Result:
True or False

JScript Example:
if ( DelDir ("/path=/users/lewis/newfolder") )

{
WriteLog ("Successfully deleted");

}

else

{
WriteLog("Failed to delete directory");

}

Basic Script Example:

If DelDir("/path=/users/lewis/newfolder") Then
WriteLog ("Successfully deleted")

Else
WriteLog("Failed to delete directory")

End If

See Also:
CreateDir

UlSelectFile

Description:
Display a standard file selection window so users can select a file

Options:

ftitle Window title. If not specified, the title will be "Please select a file

JScript Example:

UISelectFile("/title=Please select another file");

Basic Script Example:
UISelectFile("/title=Please select another file")

25
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4.3.17

C CodingFTP Enterprise

(=3[ = |

i File Edit View Help

‘ Script Library
P category1 UlSelectFile.cfs | UISelectDir.cfs |
i [F) aaTesting Seript 5.cfs i

1
2 Begin

{——-——— Script starts here,

2} New Script 2.cfs

3 lease
4 UISelectFile('/title=Flease select

of

| &End.

i ﬂ 5.cfs s c Please select a file @
i G Mew Soipt 2,
DTF] :ew Saipt.cfs Lookin: |, CodingFTP Testing - @2 M-
esting
ﬂ UIMsgBox.cfs = Name Date modif... Type Size
o g} ulselectDir.cfs ry’ — ;
@ e e =] aaaa,jpg
i Recent Places =
A (Recyde Bin) =) error.JPG
-] account testing.cfs 1
2 New Script 456 2.cfs -
_] MNew Script.cfs Desktop =
_:] SampleSaript #1.cfs 3
i
i
trudger
A
Computer
| ™9
-
Network
= File name ki
TEVIEW
| Files of type: Al Files (*.7) ']
See Also:
UlSelectDir

UlSelectDir

Description:
Display a standard directory selection window so users can select a directory

Options:
[title Window title. If not specified, the title will be "Please select a directory’
/default Default directory

JScript Example:

UISelectFile("/title=Please select another file");

Basic Script Example:
UISelectFile("/title=Please select another file")
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C CodingFTP Enterprise ==E] = |

i Ele Edit View Help

D Mew Script ~ W .
|Scnpt Library

I:J Categoryl | UlSelectrile.cfs |UISelectDir.cfs

& _—J asTesting Script 5.cfs r :

- [E] Mew Script 2.cfs fE‘ SR . i B WA s &
: _—] Mew Script.cfs i
? _] wewe.cfs
==

Browse For Folder -

Please select a directary

> Public -
48 Computer
> & Local Disk ()
4 5 Local Disk (D:)
i |} Boost
> L Software
4 | temp
J 2007110900100 (1)
J bebboost-1 34.1-5 9 2-0.2 " started in Preview mode
. CodingFTP Testing y
. Darren
. Derek " started in Preview mode
. DXSample
eMule
. eMuleTemp

mn

. firefox_download

. ftproot (|
| FTPS_Testing fditiioce  [[Modified: 2008/4/2 16:29:56 by TRUDGER-PCltrudger

>l hubert -

\

See Also:
UlSelectFile

44 Log & Notification
441 INITLogOption

Description:
Initialize log options

Options:
/path Log file name or full path. If only file name specified. The log file will be saved in the default
log directory.
For 2000/XP, the default directory is: C:\Documents and Settings\<User Name>\Application
Data\CodingFTP\Log
For Vista, the default directory is: C:\Users\<User Name>\AppData\Roaming\CodingFTP
\Logs
You can use following variables in the option:
% Script file name
SCRIPTN
AME%
Y% Year in 2 digits. e.g. 08
YEAR2%
Y% Year in 4 digits. e.g.2008
YEAR4%

%MONTH Month with one digit before Oct, two digits after Oct. e.g. 1 and 12
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%

% Month with two digits always. e.g. 01 and 12
MONTH2

%

%DAY% Use one digit if possible. e.g. 1 and 20
%DAY2% Always use two digits. e.g. 01 and 20
%HOUR% Use one digit if possible. e.g. 1 and 12
Y% Always use two digits. e.g. 01 and 12
HOUR2%

%MINUTE Use one digit if possible. e.g. 1 and 12
%

Y% Always use two digits. e.g. 01 and 12
MINUTE2

%

% Use one digit if possible. e.g. 1 and 12
SECOND

%

% Always use two digits. e.g. 01 and 12
SECOND2

%

Isize Max log file size, in MB.
loverwriteOverwrite old log file
lonlyerror Only write error to the log file. As default, all information will be written to log file

JScript Example:

INITLogOption ("/path=%SCRIPTNAME%-%YEAR4%$MONTH2%%DAY2%-%$HOUR2%$MINUTE2%$SECOND2% /size=10 /onlyerror");
Basic Script Example:

INITLogOption ("/path=%SCRIPTNAMES-%YEAR4$SMONTH2%%DAY2%-$HOUR2%SMINUTE2%%$SECOND2% /size=10 /onlyerror")
See Also:

4.4.2 WriteLog

Description:
Write log

Options:
(no
option)

JScript Example:

WriteLog ("My testing message");

Basic Script Example:
WriteLog ("My testing message")

See Also:
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443

444

SendEmail

Description:
Sending email

Options:

/subject Subject

to Recipient address

/fname  "From" name

/faddr  "From" email address

/body Email body

/bodyfile You can also put message to a local file, CodingFTP will load it when sending out email

Note:
You need to specify the SMTP server information at "Edit->Options->Email Account" before using this
command.

JScript Example:

SendEmail ("/subject=Testing message from CodingFTP /to=userl@abc.com /fname=lewis /faddr=support@codingftp.

SendEmail ("/subject=Testing message from CodingFTP /to=userl@abc.com /bodyfile=d:\temp\testingmessage.txt")

Basic Script Example:
SendEmail ("/subject=Testing message from CodingFTP /to=userl@abc.com /fname=lewis /faddr=support@codingftp.

SendEmail ("/subject=Testing message from CodingFTP /to=userl@abc.com /bodyfile=d:\temp\testingmessage.txt")

See Also:

SendResult

SendResult

Description:
Send the script result via email

Options:

/always Always email the log if specified; Otherwise, only sending when error occurred.
Nlogfile  Whether including script log in the email. Possible values:

always Always including log file in the email

error Only including log file in the email if there is any error occurred

Note:
You need to specify the SMTP server information, Recipient and "From" information at "Edit->Options-
>Email Account" before using this command.

JScript Example:

SendResult ("/always /logfile=error");

Basic Script Example:
SendResult ("/always /logfile=error")

See Also:

SendEmail
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4.5 Miscellaneous

451 ErrorText

Description:
Get the last error text

Options:
(no option)

See Also:
ErrorCode
4.5.2 ErrorCode

Description:
Get the last error code

Options:
(no option)

See Also:
ErrorText
4.5.3 GetParam

Description:
Get parameter value from command line by its name

Options:
parameter name

JScript Example:

GetParam('logfile');

Basic Script Example:

GetParam("logfile")

See Also:
454 ExitWidows

Description:
Exit Windows system

Options:

Nlogoff  Log off current user

/ Shutdown computer

shutdown

/reboot Reboot computer

/now If specified, CodingFTP will take action immediately; Otherwise, a window will be displayed

to delay for 30 seconds so users have chance to cancel the operation
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4.5.5

4.5.6

JScript Example:
ExitWindows ("/logoff");

Basic Script Example:
ExitWindows ("/logoff"

logoff Computer Li_E-J

CodingFTP will logoff the computer in 25 seconds!

[ logoff Maw! J ’ Cancel

See Also:
SetWorkingDir

Description:
Set working directory

Options:

/local Working directory on local computer
Iftp Working directory on FTP server

JScript Example:

SetWorkingDir ("/local=d:\temp\lewis /users/lewis");
Basic Script Example:

SetWorkingDir ("/local=d:\temp\lewis /users/lewis"

See Also:
GetWorkingDir

GetWorkingDir

Description:
Get working directory

Options:

/local Working directory on local computer
Iftp Working directory on FTP server
Result:

Local or FTP working directory

JScript Example:

GetWorkingDir ("/local");

31
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Basic Script Example:
GetWorkingDir ("/local™) ' get local work

See Also:
SetWorkingDir

4.5.7 UlMsgBox

Description:
Show a message box

Options:

/msg Message
ltype Icon type. Possible values:

Inform

ation

Confir When user clicked "Yes" button, it function returns "YES"; Otherwise, it returns "NO".
mation

Warnin

JScript Example:
if ( UIMsgBox ("/msg=Are sure to exit? /type=Confirmation") == "YES" )

"ked

4 I Cllic ou

Else

See Also:
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4.5.8 UlAskinput

Description:
Ask user input

Options:
/prompt Prompt message

/default Default text in edit box
/passwd Password mode, show input as "*"

Result:
User input

JScript Example:

UIAskInput ("/prompt=Please input username /default=lewis");

Basic Script Example:
UIAskInput ("/prompt=Please input username /default=lewis")

'

Please input

Flease input username

See Also:
4.5.9 Uppercase

Description:
Convert all characters to upper case

Options:
(no
option)

Result:
String

JScript Example:

Uppercase ("abcDE"); // Returns "ABCDE"

Basic Script Example:
Uppercase ("abcDE") ' Returns 'ABCDE'

33
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4.5.10 Lowercase

Description:
Convert all characters to lower case

Options:
(no
option)

Result:
String

JScript Example:

Uppercase ("abcDE") ;

Basic Script Example:
Uppercase ("abcDE") ' Returns "abcde"

4.5.11 NameCase

Description:
Convert the first character in a word to uppercase and all other characters in lowercase.

Options:
(no
option)

Result:
String

JScript Example:

NameCase ("my NAME"); // Returns "My Name"

Basic Script Example:
NameCase ("my NAME") ' Returns 'My Name'

4.5.12 Trim

Description:
Remove all space characters on the beginning and the end of the string. The space characters in
middle of the string will not be removed

Options:
(no
option)

Result:
String
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JScript Example:
Trim(" 123 4 ");

Basic Script Example:
Trim(" 123 4 ") ' Returns '123 4"

4.5.13 ToStr

Description:
Convert a integer value to string. It's required when you need to display the integer value. For example,
using WriteLog to output it.

Options:
(no
option)

Result:
String

JScript Example:
WriteLog (ToStr (123));

Basic Script Example:
WriteLog (ToStr(123)

4.5.14 ToNumber

Description:
Convert a string value to a number

Options:
(no
option)

Result:
String

JScript Example:

1 + ToNumber("2"); // returns 3

Basic Script Example:
1 + ToNumber ("2") ' returns 3
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5.1

5.2

Script HowTo

How to use variable?

For example:

Java Script

myname = "John";
WriteLog (myname) ;

Basic Script

myname = "John"
WriteLog (myname)

There are two methods to use variable in command parameter string. For example, we have two
variables:

username = "John";
passwd = "mypasswd";
Method #1:

Normally, we need to use "+" to join these variables like this:
OpenHost ("/host=localhost /username=" + username + " /passwd=" + passwd) ;

The actual parameter Coding FTP get will be:

"/host=localhost /username=John /passwd=mypasswd"

Method #2:

However, Coding FTP provides another more convenient method:
OpenHost ("/host=localhost /username=Susername /passwd=S$passwd");

As you can see, you can add a prefix, $, to the variable name. Coding FTP will replace them with the
real value during running.

The actual parameter Coding FTP get will be: "/host=localhost /username=John /passwd=mypasswd"
It's the same as method #1.

How to write procedure myself?

To write a custom function in Java Script, please use "function ... {...}". In VB Script, please use "Sub...
End Sub".

JScript Example:

function MyPrint (msg)
{
MsgBox (msq) ;
WriteLog (msq) ;
}

MyPrint ("my message") ;
Basic Script Example:

Sub MyPrint (msg)
MsgBox (msg)
WriteLog (msg)

End Sub

MyPrint ("my message")
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6.1

6.2

FAQ

How to run script from command line?
You can easily to integrate Coding FTP with your work flow by using command line.
The command line is easy:

e |f the script under default script library directory, you can simply use script name in command line:
codingftp.exe /script=script1.cfs

e |f the script file doesn't exist in default script library, you need to specify the full path of the script
file:
codingftp.exe /script=d:\mydata\testing.cfs

How to upgrade my license?
Coding FTP has two licenses: Professional and Enterprise.

If you want to upgrade your license, please:

1) Email us at sales@codingftp.com and let us know your current license information and the license
type you want to purchase

2) We'll send you an ordering link. The price will be the difference between two editions plus $3.

3) Please using the ordering link we sent to you to complete the order. The new license information will
be sent to you within minutes

4) When you get the registration email, please click "Help->License Information" and enter new license
code
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71

7.2

Service

Script Writing Service
We provide not only CodingFTP but also Scripts Writing Service!

if you have no any knowledge about coding or you simply don't want to take time to write the script. For
either case, we are glad to write the script for you at a reasonable fee.

There are three types of script:

A Class Script: Needs less than one hour to write and debug

B Class Script: Needs less than three hours to write and debug
C Class Script: Needs less than 48 hours to write and debug

More information about SWS, please visit http://www.codingftp.com/sws.php

Note: This service is only available for registered users. If you didn't register CodingFTP yet, please

click here to buy a license today!

Customized Version

Thanks to the excellent design of Coding FTP, we are able to expand Coding FTP easily. So we
provide this service for you. If you think Coding FTP suits most of your needs but lacks some important
features to you. Please don't hesitate to contact us. We can discuss the possibility of Customized
Version.

More information about Customized Version service, please visit http://www.codingftp.com/
customized.php
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8 Tech Support

e Discussion Forum
You can also post your questions on discussion forum. It's also a good place to get our support

e Contact Form
You can also use the online form to send message to us.

e Email
If you have any question or encountered any problem, you can contact our support team at
support@codingftp.com

Note: If you are a registered users, please use the registration email to send out message so you can
get priority support.
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